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KASHMIR CIVIL SERVICES ACADEMY 
TOP 60 IMPORTANT QUESTIONS ON MS ACCESS PART I 

1. Microsoft Access is 
a) RDBMS 
b) OODBMS 
c) ORDBMS 
d) Network Database Model 
Correct Ans: a) RDBMS 
2. Which of the following is not a type of Microsoft Access database object? 
a) Table 
b) Form 
c) Worksheets 
d) Modules 
Correct Ans: c) Worksheets 
3. Called a field in a column in a table 
a) Database 
b) Attribute 
c) Tuple 
d) Data 
Correct Ans: b) Attribute 
4. Record is 
a) Row 
b) Column 
c) Row and column group 
d) None of these 
Correct 
Ans: a) Row 
5. A column in a relation whose data value is used in the second relation as a 
key column, which is said to be – 
a) Primary key 
b) Composite key 
c) Foreign key 
d) Candidate key 
Correct Ans: c) Foreign key 
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KASHMIR CIVIL SERVICES ACADEMY 
6. Collection of the field is called 
a) Record 
b) Column 
c) File 
d) Table 
Correct Ans: a) Record 
7. Which key is used to make the unique field? 
a) Primary key 
b) Foreign key 
c) Index Key 
d) Composite key 
Correct Ans: a) Primary key 
8. What is the extension name of the database created in Ms Access? 
a) .mdb 
b) .mad 
c) .doc 
d) None of these 
Correct Ans: a) .mdb 
9. A tree structure can be established as ________ Relationship 
a) One to One 
b) Many to Many 
c) One to Many 
d) Many to One 
Correct Ans: c) One to Many 
10. What is DBMS? 
a) Database Management System 
b) Database Manager System 
c) Data Management System 
d) None of these 
Correct Ans: a) Database Management System 
11. Relation Model is related to 
a) Data Structure and Data Integrity 
b) Data Manipulation 
c) Both 
d) None of these 
Correct Ans: c) Both 
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KASHMIR CIVIL SERVICES ACADEMY 
12. Which of the following is the example of Network Database? 
a) Oracle 
b) Ingress 
c) IDMS 
d) None of these 
Correct Ans: a) Oracle 
13. Hierarchical Data model 
a) Partially ordered 
b) Totally ordered 
c) Not ordered 
d) None of these 
Correct Ans: a) Partially ordered 
14. Overall design of database is called 
a) Database Screen 
b) Database Structure 
c) Database view 
d) None of these 
Correct Ans: b) Database Structure 
15. Boyce-code is the Normal Form 
a) 1 NF 
b) 2 NF 
c) 3 NF 
d) 4 NF 
Correct Ans: d) 4 NF 
16. The first form of the Normalization is _______ 
a) First Normal Form 
b) Second Normal Form 
c) Fifth Normal Form 
d) None of these 
Correct Ans: a) First Normal Form 
17. Functional dependency occurs 
a) First Normal Form 
b) Second Normal Form 
c) Third Normal Form 
d) Fourth Normal Form 
Correct Ans: c) Third Normal Form 
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18. The category of information in a database table is called _______ 
a) Field 
b) Tuple 
c) File 
d) Record 
Correct Ans: a) Field 
19. The default and maximum size of the text field in the Ms Access 
a) 50 and 255 characters 
b) 8 and 1 Gb 
c) 256 characters and 64000 characters 
d) None of these 
Correct Ans: a) 50 and 255 characters 
20. Which of the DBMS packages is not available? 
a) Database 
b) Record 
c) Field 
d) File 
Correct Ans: d) File 
21. Referential integrity occurs 
a) Table 
b) Database 
c) Query 
d) All of these 
Correct Ans: d) All of these 
22. Which property should be follow for a table? 
a) Each column should have separate headings 
b) Duplicate row entries should not be entered 
c) Both 
d) None 
Correct Ans: c) Both 
23. Presenting them in Two – dimensional table between all data items and 
relationships is called 
a) Database 
b) Relation 
c) Normalization 
d) Anomaly 
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KASHMIR CIVIL SERVICES ACADEMY 
Correct Ans: b) Relation 
24. The process of simplifying Relationships is called — 
a) Database 
b) Relation 
c) Normalization 
d) Anomaly 
Correct Ans: c) Normalization 
25. Which of these is not the type of anomaly check? 
a) Update 
b) Delete 
c) Select 
d) Insert 
Correct Ans: c) Select 
26.The attribute that is not part of any candidate key is called. 
a) sub-prime attribute 
b) non-prime attribute 
c) sub-candidate key 
d) non-candidate key 
Correct Ans: (b) non-prime attribute 
27. An attribute of a table cannot hold more than one value 
a) First normal form (1NF) 
b) Second normal form (2NF) 
c) Third normal form (3NF) 
d) Fourth general form (4NF) 
Correct Ans: (a) First normal form (1NF) 
28. A key to identifying row specifically in the table consists in more than one 
attribute that is said. 
a) Composite key 
b) Candidate key 
c) Primary key 
d) Foreign key 
Correct Ans:(a) Composite key 
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29. In the hierarchical model, the date is organized. 
a) Logical structure 
b) Physical structure 
c)Tree like structure 
d) None of these 
Correct Ans: (c) Tree like structure 
30. What does ‘Double Rectangles’ show in Entity-Relationship diagram? 
a) Relationship set 
b) Weak Entity sets 
c) Derived Attributes 
d) Multi-valued attributes 
Correct Ans: (b) Weak Entity Sets 
31. Database Management System (DBMS) is: 
a) Collection of interrelated data (collection of interlinked data) 
b) Collection of programs to access data (collection of programs for using data) 
c) Collection  of  data  describing  one  particular  enterprise  (description  of  a 
particular enterprise, collection of data) 
d) All of the above (all) 
Correct Ans: (d) All of the above (all) 
32. In the Entity-Relationship Diagram Rectangles shows: 
a) Entity sets 
b) Attributes 
c) Database 
d) Tables 
Correct Ans:(a) Entity sets 
33. What is the Data Model? 
a) Entity Relationship model 
b) Relationship data model 
c) Object Based data model 
d) All 
Correct Ans:(d) All 
34. Which of the following shows the relation between a set of values? 
a) A Row 
b) A Table 
c) A Field 
d) A column 
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KASHMIR CIVIL SERVICES ACADEMY 
Correct Ans: (a) A Row 
35. Column header is mentioned as. 
a) Table 
b) Relation 
c) Attributes 
d) Domain 
Correct Ans: (c) Attributes 
36. The component of ER Model 
a) Entity 
b) Attributes 
c) Relationship 
d) All 
Correct Ans:(d) All 
37. A collection is in a relational database, 
a) Tables 
b) Fields 
c) Records 
d) Keys 
Correct Ans: (a) Tables 
38. Which of the following is not a modification of the database 
a) Deletion 
b) Inserting 
c) Sorting 
d) Updating 
Correct Ans:(c) Sorting 
39. In Entity-Relationship Diagram ‘Ellipses’ Shows 
a) Attributes 
b) Weak entity set 
c) Relationship sets 
d) Multi-valued attributes 
Correct Ans: (a) Attributes 
40. In Entity-Relationship Diagram ‘Diamonds’ Shows 
a) Attributes 
b) Weak entity set 
c) Relationship sets 
d) Multi-valued attributes 
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Correct Ans: (c) Relationship sets 
41. If every non-key attribute is functionally dependent on the primary key, the 
relation will be formed 
a) First Normal Form 
b) Second Normal Form 
c) Third Normal Form 
d) Fourth Formal Form 
Correct Ans: (c) Third Normal Form 
42. What is the types of key in the Database Design? 
a) Candidate key 
b) Primary key 
c) Foreign key 
d) All of these 
Correct Ans: (d) All of these 
43. Boyce-Codd Normal Form is a simpler form of _______ 
a) 1NF 
b) 2NF 
c) 3NF 
d) 4NF 
Correct Ans: (c) 3NF 
44. What is a form in MS Access ? 
a) This is a printed page where users wil write their data to fill it. 
b) It is designed to look at input screen and make data easier 
c) It is an important part of the database to findout the conclusions by the analyst 
d) All 
Correct Ans: (b) It is designed to look at input screen and make data easier 
45. Which of these is not a type of relationship, Which can be implemented in 
the Access database ? 
a) One to one 
b) One to Many 
c) Many to Many 
d) All of the above can be applied 
Correct Ans:(d) All of the above can be applied 
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46. How many objects are there in Ms Access? 
a) 4 
b) 3 
c) 7 
d) 6 
Correct Ans: (c) 7 
47. This key uniquely identifies each record 
a) Primary key 
b) Key record 
c) unique key 
d) field name 
Correct Ans: (a) Primary key 
48. There is a third stage in the preparation of databases, when we analyze our 
database more closely and create a _______ between table 
a) Relationship 
b) Join 
c) Query 
d) None of these 
Correct Ans: (a) Relationship 
49. This key uniquely identifies each record 
a) Primary key 
b) Key record 
c) unique key 
d) field name 
Correct Ans: (a) Primary key 
50. Which of the following contain database objects data? 
a) Forms 
b) Reports 
c) Queries 
d) Tables 
Correct Ans:(d) Tables 
51. In MS-Access Shortcut key CTRL + O used for which purpose ? 
A) Open a new database 
B) Open an existing database 
C) Exit MS-Access 
D) None of these 
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KASHMIR CIVIL SERVICES ACADEMY 
Correct Answer: b) Open an existing database 
52. In how many ways can I create a table in MS Access ? 
A) 1 
B) 2 
C) 3 
D) 4 
Correct Answer: c) 3 
53. How many types of data type is in MS Access ? 
A) 6 
B) 4 
C) 8 
D) 10 
Correct Answer: d) 10 
54. This data type allows alphanumeric characters and special symbols ? 
A) text 
B) memo 
C) auto number 
D) None of the above 
Correct Answer: a) text 
55. In order to create a new table, in which method you do not need to specify 
the field type and size ? 
A) Create table in Design View 
B) Create Table using wizard 
C) Create Table by Entering data 
D) All of above 
Correct Answer: c) Create Table by Entering data 
56. Can not be the size of the field with the number data type 
A) 2 
B) 4 
C) 8 
D) 16 
Correct Answer: d) 16 
 
 
 
 

mailto:kashmircivilservicesacademy@gmail.com
mailto:kashmircivilservices@gmail.com


 

KASHMIR CIVIL SERVICES ACADEMY- A Premier Coaching Institute For IAS, KAS & JKSSB Examinations Page 12 
Contact Us at: Spark Building, Opposite Pandit Uniform House, K.P Road Anantnag. 
Ph. No. +91 7006139419, +91 7006266678 
Email Us at: kashmircivilservicesacademy@gmail.com, kashmircivilservices@gmail.com  
 
 

KASHMIR CIVIL SERVICES ACADEMY 
57. What is the default field size in text field type’s? 
A) 20 Characters 
B) 25 Characters 
C) 50 Characters 
D) 30 Characters 
Correct Answer: c) 50 Characters 
58. Size of the field of Yes / No field? 
A) 1 bit 
B) 1 byte 
C) 1 character 
D) 1 GB 
Correct Answer: a) 1 bit 
59. When a new table is created that can be used to select fields from standard 
database and tables ? 
A) Create table in Design View 
B) Create Table using wizard 
C) Create Table by Entering data 
D) None of above 
Correct Answer: b) Create Table using wizard 
60. When we are making a new table and if we need to enter long text in a field 
then what data type will be selected ? 
A) Text 
B) Memo 
C) Currency 
D) Hyperlink 
Correct Answer: b) Memo 
61. What is the maximum size of the text data type? 

A) 200 Characters 

B) 500 Characters 

C) 255 Characters 

D) 300 Characters 

62. What field width is 8 bytes? 

A) Memo 

B) Number 
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C) Date / Time 

D) Hyperlink 

63. Which of the following is not view to display the table in Access? 

A) Datasheet View 

B) Design View 

C) Pivot Table & Pivot Chart View 

D) None of above 

64. Which type of data is used to store more data than 255 characters? 

A) Text 

B) Memo 

C) Alphanumeric 

D) Number 

65. Which of the following data types can create a Drop down list? 

A) OLE Object 

B) Hyperlink 

C) Memo 

D) Lookup Wizard 

66. Which menu is used to sort a field ? 

A) View 

B) Records 

C) Tools 

D) Format 

67. What is called the columns in the Microsoft Access Table? 

A) Rows 

B) Records 

C) Fields 

D) Columns 
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68. Which of these is the option of filters? 

A) Filter by form 

B) Excluding Selection 

C) Filter by selection 

D) All 

69. To freeze any column, option is present in which menu? 

A) View 

B) Records 

C) Tools 

D) Format 

70. There are a paste option in the table– 

A) Structure Only 

B) Structure and data 

C) Append Data to Existing 

d. All of the above 

71. How can the table be made in the following? 

A) By Design view 

B) By data sheet 

C) By wizard 

D) All 

72. What is the category of information in a database table? 

A) Tuple 

B) Record 

C) Field 

D) All of the above 

73. What is called for field in a column of a table? 

A) Database 

B) Attribute 
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C) Tuple 

D) Data 

74. How much of character of data can store in Text Data Type? 

A) 50 

B) 255 

C) 256 

D) 56 

75. Used in Text Type Data Type – 

A) To store text 

B) To store the number 

C) For both 

D) None of these 

76. There is a paste option in the table- 

A) Structure only 

B) Structure and data 

C) Append data to existing 

D) All of the above 

77. Which option is used to find any record from a particular field in the table ? 

A) Find and replace 

B) Search record 

C) Go To 

D) None of these 

78. Why MEMO Data Type is used? 

A) For long description 

B) Currency value to store 

C) Numerical value to store 

D) None of these 
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79. A field can have a maximum number of character names in the table. 

A) 64 

B) 32 

C) 52 

D) 11 

80. What data type is used to store logical value in the table in MS ACCESS? 

A) True / False 

B) Yes/ No 

C) On / off 

D) None of these 

81. Which of the following data type is used to insert objects of voice, image, 

word, excel etc. or to link objects? 

A) Hyperlink 

B) OLE 

C) Text 

D) Number 

82. How many types of formats are there for Ms Access Date type? 

A) 4 

B) 5 

C) 7 

D) 9 

83. How much value can we store in the Byte Field size of the Number Data 

type? 

A) 10 

B) 5 

C) 2 

D) 3 
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84. How much value can we store in the integer Field size of the Number Data 

type? 

A) 10 

B) 5 

C) 2 

D) 3 

85. How much value can we store in the Long Integer Field size of the Number 

Data type? 

A) 10 

B) 5 

C) 9 

D) 3 

86. How much value can we store in the double field size of Number Data type? 

A) 10 

B) 5 

C) 9 

D) 3 

87. Which of these field does not appear in the design view Windows? 

A) Field Name 

B) Description 

C) Data Type 

D) Field size 

88. What is the Shortcut key of replace in Ms-Access? 

A) Ctrl + h 

B) Ctrl + r 

C) Ctrl + f 

D) Alt + r 
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89. What option is used to modify the structure of the table? 

A) Wizard 

B) Design view 

C) Edit 

D) None of these 

90. The option to hide any column is present in which menu? 

A) View 

B) Record 

C) Tool 

D) Format 

91. Operations are in Relationship– 

a) Define relationships 

b) Save relationship 

c) Delete relationship 

d) All of the above 

92. Why Append Query is used? 

a) To copy a table data to another table 

b) To delete the Query 

c) To save the Query 

d) To update Query 

93. Find duplicate record query is used 

a)To delete duplicate record 

b) To find duplicate record 

c) To update duplicate record 

d) To create query 

94. Which query is used to see Unmatched Record from Table or Query? 

a) Append Query 

b) Find duplicate Query 
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c) Find Unmatched Query 

d) Update Query 

95. Why Cross tab Query is used? 

a) To analyze data 

b) To update Record 

c) To delete Record 

d) Duplicate record to search 

96. What is most commonly used query? 

a) Select Query 

b) Action Query 

c) Cross tab Query 

d) SQL Query 

97. How to get the same information from more than one table? 

a) Normalization 

b) Relationship 

c) Query 

d) Report 

98. What is necessary to create a relationship between two tables? 

a) Tables 

b) Key 

c) Field 

d) All 

99. Which of these key is formed on the basis of relationships? 

a) Composite key 

b) Candidate key 

c) Primary key 

d) Foreign key 
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100. Which of these is not an option of referential integrity? 

a) Cascade update related fields 

b) Enforce Referential Integrity 

c) Normalization 

d) Cascade deletes related fields 

101. The following is not the type of Query? 

a) Cross tab Queries 

b) Select Queries 

c) Query by selection 

d) Append 

102. Which of the following is not the type of Action Query? 

a) Make table 

b) Cross tab Query 

c) Delete Query 

d) Append 

103. Which of these is not the option of Query design window? 

a) Criteria 

b) Table 

c) Sort 

d) Format 

104. Which of these is the option of “Duplicate Query Wizard”? 

a) Record Menu 

b) Format Menu 

c) New Query Window 

d) Tools 

105. Which of these is the option of the New Query Window? 

a) Find unmatched Query wizard 

b) Simple Query wizard 
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c) Find duplicate query wizard 

d) All 

106. You can use query in Access 

a) To view, modify and analyze data in different ways 

b) A source of record for form and reports 

c) Just a 

d) Both a and b 

107. To create query in Ms-Access– 

a) You can drag and drop a field on query builders 

b) You can type SQL command in SQL view 

c) You can use the query wizard or the design view 

d) All 

108. Query design window consist of two part – are in the upper part 

a) Field Name, Field Type and size 

b) Table with fields and relationship between Tables 

c) Criteria 

d) Sorting check boxes 

109. What is indicate Check box appearing in query design window? 

a) It indicates whether this field should be used or not 

b) It indicates whether the field should display the query result or not 

c) It indicates whether the field names are displayed in the query result or not 

d) None of these 

110. How can you add a table to the query design window? 

a) Select Edit > Add table from the menu 

b) Select Tools > Add table from the menu 

c) Click the show table button 

d) Select the table from the table list on the toolbar 
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111. Which of these relationships cannot apply to access database? 

a) One to one 

b) One to Many 

c) Many to Many 

d) None of these 

112. To create a relationship between two table 

a) Drag the primary key of a table into the foreign key of the second table 

b) Drag the foreign key of a table into the primary key of the second table 

c) Drag a table into the parent table and drop it on the child table 

d) Anyone above can be made to make a relationship 

113. What does one to many relationship mean between student and class 

table– 

a) Many different classes of a student 

b) There may be many Students in a class 

c) There may be many Students in many class 

d) Many students can have many different classes 

114. In the One-to-many relationship in the table ‘one’ side is called ____ and 

‘many’ side is called____ 

a) Child, Parent 

b) Parent, Child 

c) Brother, sister 

d) Father, Son 

115. We can remove the relationship created between two tables— 

a) Select Delete Relationship from Edit menu 

b) Select the relationship line and press delete 

c) Select the Delete option from the relationship menu 

d) All of above 
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116. If you want to edit the relationship — 

a) Right click on the relationship line and choose Edit Relationship 

b) Double click on the relationship line 

c) Both of above 

d) None of above 

117. There are option in the filter 

a) Filter by form 

b) Filter by selection 

c) Filter excluding selection 

d) All of the above 

118. Relationships are possible– 

a) In a field inside a table 

b) Between two table 

c) Both A and B 

d) None of these 

119. Queries create 

a) By filter 

b) From the table 

c) Both a and b 

d) None of these 

120. AND OR operation are specified– 

a) In field 

b) In criteria 

c) In sort 

d) None of these 
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121. There are types of Tabular and ______ form layouts that display more than 

one record at the same time? 

a) Columnar 

b) Justified 

c) Data sheet 

d) Pivot table 

122. How many forms are there? 

a) 2 

b) 6 

c) 3 

d) 4 

123. Which of these statements is true? 

a) Form is used for input 

b) Forms program are even drives 

c) You can calculate multiple fields in the form 

d) All 

124. Which of the following is not form Layout? 

a) Tabular 

b) Datasheet 

c) Web Layout 

d) Justified 

125. How many modes are there to create a form in ms access? 

a) 2 

b) 1 

c) 3 

d) 4 
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126. What is the shortcut key to display the first record in Form? 

a) Shift + Home 

b) Ctrl + Home 

c) Alt + Home 

d) Alt + shift + Home 

127. ________ Property is set for display the type of Object 

a) Data 

b) Format 

c) Event 

d) Other 

128. Combo box design is 

a) In table 

b) In Query 

c) In Form 

d) In all the above 

129. Sub Form is 

a) Second form with current form 

b) A separate Form 

c) Table Form 

d) None of the above 

130. List box control is used — 

a) For single selection 

b) For the multiple list 

c) For editing 

d) None of them 
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131. Which of the following is the form type —? 

a) Datasheet 

b) Justified 

c) Tabular 

d) All 

132. By which of these controls can create drop down list? 

a) List Box 

b) Command Button 

c) Combo Box 

d) None of these 

133. Which control is used for Data entry? 

a) Toggle Button 

b) Option Group 

c) Text box 

d) Label 

134. Which control is used to display multiple pages? 

a) Bound Object Frame 

b) Combo Box 

c) Tab 

d) Rectangle 

135. Which of these layout displays data as field? 

a) Tabular 

b) Columns 

c) Justified 

d) Datasheet 
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136. Which layout is used to display information in the table? 

a) Tabular 

b) Columns 

c) Justified 

d) Datasheet 

137. What is the shortcut key to display the first record? 

a) Shift + Home 

b) Ctrl + Home 

c) Ctrl+shift + Home 

d) Windows+ Home 

138. Which of these control is used to display a bitmap image? 

a) Image 

b) Bound Object Frame 

c) Picture box 

d) Unbound object 

139. __________ control is used to display the message? 

a) Text box 

b) List box 

c) Label 

d) Check box 

140. The combination of Multiple Toggle Buttons, Option Buttons or Check Box 

is a_______ 

a) Option group 

b) Command Button 

c) Sub form 

d) Unbound object 
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